IMPROVE DATACENTER ENERGY EFFICIENCY WITH INTEL NODE MANAGER

BALANCING POWER AND PERFORMANCE

Take control of your datacenter with Intel”Node Manager
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The server virtualization wave has helped to reduce the number of servers and power consumption
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datacenters need to keep business moving, but most of the time, those servers are not optimized to efficiently
balance energy consumption and performance. They’re just burning power by running inefficiently 24 hours a
day, 7 days a week. Intel Node Manager, a server firmware feature that works with Intel Xeon processors, is a
power management tool that can help you optimize the balance between compute resources and energy
consumption to make your infrastructure more efficient and save you money in operating expenses.
In the Principled Technologies datacenter, we found that compared to running a server without power
management, managing power with Intel Node Manager enabled:
e 42.8 percent more performance/watt for a mixed workload when limiting server power
consumption to 70%
e 19.7 percent more performance/watt on a storage-intensive workload when limiting server power
consumption to 65%

e 13.2 percent more performance/watt on a memory-intensive workload when limiting server power
consumption to 70%

e 11.1 percent more VDI sessions/watt on a CPU-intensive workload when limiting server power
consumption to 70%
These results show the value of managing power with Intel Node Manager: When you get more
efficient, you make the most of every watt your datacenter consumes and spend less on wearying energy costs
while maximizing performance within your power budget.
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MANAGING DATACENTER POWER WITH INTEL NODE MANAGER

Power capping lets admins
plan power and cooling
capacity for the whole
datacenter. With caps in
place, admins need not
worry that an unexpected
performance peak will
overload a system or rack,
trip a circuit, and bring
down important
workloads. This strategy
eliminates the
unnecessary power and
cooling overhead that
admins traditionally leave
to handle these
unexpected spikes.

Intel Node Manager is a server firmware feature available Intel Xeon processor
E3, E5, and E7 family servers that lets IT administrators balance processor resources
with power and cooling. With Intel Node Manager, administrators use a management
console to set power policies that help make the most of each rack in the datacenter.
By managing energy to increase efficiency, Intel Node Manager has the
potential to help businesses:
e reduce ongoing operating costs datacenter wide
e balance resources dynamically by moving power and cooling resources
to the workloads that need them
e improve continuity by limiting hardware’s ability to overheat and fail
By dynamically limiting power with Intel Node Manager, administrators can find
the optimal power limit that maximizes efficiency without hurting performance. Power
capping works to increase performance per watt because there is a point at which each
additional watt of power used no longer has a similar corresponding increase in
performance. Not all users in all situations want to optimize for performance/watt. If
you want to optimize for absolute performance, you should leave the servers
unconstrained.
For details about the workloads we used in our tests, see Appendix A. For
detailed test results, see Appendix B. Start at Appendix C for our step-by-step test
methodology.

Increase energy efficiency for all kinds of workloads

Using Intel Node Manager increased energy efficiency for the four types of
workloads we tested, increasing performance per watt by as much as 42.8 percent (see
Figure 1). Maximizing the amount of performance a server can do per watt of power
used is important because ultimately the cost of powering and cooling hardware is a
large part of a datacenter’s budget, so it’s more cost efficient to consider a

performance/watt metric.
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Figure 1: Intel Node Manager
let us set power capping
policies that increased
performance/watt for various
common workloads.

Mixed workload

Figure 2: Using Intel Node

Manager to set a power cap
increased performance/watt
up to an optimized 70% cap.
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As Figure 2 shows, capping power with Intel Node Manager increased
performance/watt for our Exchange/LoadGen mixed workload by 42.8 percent at the 70
percent power level compared to running the workload with no power cap. Cutting
power lower than 70 percent caused the mixed workload test to fail due to CPU
constrictions.
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Storage-intensive workload

As Figure 3 shows, capping power with Intel Node Manager increased
performance/watt for our database storage-intensive workload by 19.7 percent at the
65 percent power level compared to running the workload with no power cap. Because
further capping decreased performance/watt, we know that 65 percent is the optimal
power level for this |0-intensive test.
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Performance/watt for a storage-intensive workload
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Memory-intensive workload
As Figure 4 shows, capping power with Intel Node Manager increased

performance/watt for our SPECjbb memory-intensive workload by 13.2 percent at the
70 percent power level compared to running the workload with no power cap. Because
further capping decreased performance/watt, we know that 70 percent is the optimal
power level for this memory-intensive test.
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CPU-intensive workload
As Figure 5 shows, capping power with Intel Node Manager increased

performance/watt for our CPU-intensive VDI workload by 11.1 percent at the 70 percent
power level compared to running the workload with no power cap. Because further
capping decreased performance/watt due to slow application response, we know that
70 percent is the optimal power level for this VDI workload.
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Performance/watt for a CPU-intensive workload
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CONCLUSION

Managing power in the datacenter can be a good strategy to reduce power and
cooling overheard while allowing servers operate at the most efficient power levels and
do as much work as possible within your specific power policies.

We found that using Intel Node Manager to set power limits on servers running
various workloads increased performance per watt by up to 42.8 percent compared to

running the same workloads with no power management solution.
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APPENDIX A — ABOUT THE BENCHMARKS

Benchmarking a mixed workload using LoadGen 2013
To test the solutions’ mail server performance, we used the Microsoft Load Generator 2013 (LoadGen)

benchmark, performing tasks to simulate an Average user generating mail activity. For our workloads, we used the
following settings:
e Number of users: 2,000
o Mailbox Profile: 250MB mailboxes
e Action Profile: 300 - Outlook 2007 cached
For more details about LoadGen, see www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-
4D66-A82F- 8D3062C6FA98&displaylang=en.

Benchmarking a storage-intensive workload using DVD Store Version 2.1
To create our real-world OLTP workload, we used the DVD Store Version 2.1 benchmarking tool. DS2 models an

online DVD store, where customers log in, search for movies, and make purchases. DS2 reports these actions in orders
per minute that the system could handle, to show what kind of performance you could expect for your customers. The
DS2 workload also performs other actions, such as adding new customers, to exercise the wide range of database
functions you would need to run your ecommerce environment.

Learn more at www.delltechcenter.com/page/DVD+Store.

Benchmarking a memory-intensive workload using SPECjbb2005
SPECjbb2005 is an industry-standard benchmark created by the Standard Performance Evaluation Corp. (SPEC)

to measure a server’s Java performance. (Note: SPEC and the SPECjbb2005 are trademarks of the Standard Performance
Evaluation Corporation.) SPEC modeled SPECjbb2005 on the three-tier client/server architecture, with the middle layer
as the primary focus. According to SPEC, “Random input selection represents the first (user) tier. SPECjbb2005 fully
implements the middle tier business logic. The third tier is represented by tables of objects, implemented by Java
Collections, rather than a separate database.” (www.spec.org/jbb2005/docs/UserGuide.html).

SPECjbb2005 utilizes multiple special data groups and multiple threads as it runs. Each data unit is a
“warehouse,” a roughly 25MB collection of data objects. Each thread represents an active user posting transaction
requests within a warehouse. The benchmark run begins with one warehouse and then increases the number of
warehouses; its goal is to saturate the server’s processor capacity. As the number of warehouses increases, so does the
number of threads. The benchmark’s results portray the server’s throughput in business operations per second or

SPECjbb2005 bops. A higher number of SPECjbb2005 bops is better. For more information on SPECjbb2005, go to
WWW.Spec.org.
Benchmarking a CPU-intensive workload using Login VSI 4.1
Login Virtual Session Indexer (Login VSI) is a tool that helps assess the virtual desktop performance, capacity,
and scalability of servers.
Login VSI 4.1 reports the following metrics:
e  Minimum Response: The minimum application response time

e Average Response: The average application response time

Improve datacenter energy efficiency with Intel Node Manager A Principled Technologies report 6



e  Maximum Response: The maximum application response time
e VS| Baseline: Average application response time of the first 15 sessions
e VSl Index Average: The VSl index average is the average response time dropping the highest and lowest

2 percent
For more information about Login VSI 4.1, see www.loginvsi.com/product-overview.

Improve datacenter energy efficiency with Intel Node Manager A Principled Technologies report 7
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APPENDIX B — DETAILED TEST RESULTS

Mixed workload
Figure 6 shows the power consumption profile over the course of the test, and Figure 7 shows CPU utilization.
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Figure 6: Power consumption profile over the course of our mixed workload test.
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Figure 7: CPU utilization over the course of our mixed workload test.
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Storage-intensive workload
Figure 8 shows the power consumption profile over the course of the test, and Figure 9 shows CPU utilization.
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Figure 8: Power consumption profile over the course of our storage-intensive workload test.
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Figure 9: CPU utilization over the course of our storage-intensive workload test.
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Memory-intensive workload
Figure 10 shows the power consumption profile over the course of the test, and Figure 11 shows CPU utilization.

Note that in this memory-intensive test, high CPU is a results of high memory utilization.
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Figure 10: Power consumption profile over the course of our memory-intensive workload test.
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Figure 11: CPU utilization over the course of our memory-intensive workload test.
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CPU-intensive workload

Figure 12 shows the power consumption profile over the course of the test, and Figure 13 shows CPU utilization.
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Figure 12: Power consumption profile over the course of our CPU-intensive workload test.
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Figure 13: CPU utilization over the course of our CPU-intensive workload test.
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APPENDIX C—- SYSTEM CONFIGURATION INFORMATION

Figure 14 provides detailed configuration information for the test system.

System

| Intel S2600WT2

Power supplies

Total number 2

Vendor and model number DPS-750XB A
Wattage of each (W) 750

Cooling fans

Total number 6

Vendor and model number Nidec UltraFlo V60E12BS1B5
Dimensions (h x w) of each 2.5” X2.5”
Volts (V) 12

Amps (A) 1.50

General

Number of processor packages 2

Number of cores per processor 12

Number of hardware threads per core 2

System power management policy Performance
CPU

Vendor Intel

Name Xeon

Model number E5-2680 v3
Socket type LGA2011-3
Core frequency (GHz) 2.5

Bus frequency 9.6 GT/s DMI

L1 cache 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache 30 MB
Platform

Vendor and model number

Intel S2600WT2

Motherboard model number

Intel S2600WT2

BIOS name and version

SE5C610.86B.01.01.1008 (03/19/2015)

BIOS settings

Default

Memory module(s)

Total RAM in system (GB)

256

Vendor and model number

SK Hynix HMA42GR7MFR4N-TF

Type

PC4-2133P

Speed (MHz) 2,133
Speed running in the system (MHz) 2,133
Timing/Latency (tCL-tRCD-tRP-tRASmin) 15-15-15-33
Size (GB) 16

Number of RAM module(s) 16

Chip organization Dual sided
Rank Dual

Improve datacenter energy efficiency with Intel Node Manager
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System

Intel S2600WT2

Operating system

Name VMware ESXi 6.0.0
Build number 2494585

File system VMFS

Language English

Graphics

Vendor and Model Number

Matrox® G200

Graphics memory (MB)

256

RAID controller

Vendor and model number

Intel Onboard SAS Controller

Firmware version

SE5C610.86B.01.01.1008 (03/19/2015)

Hard drives

Vendor and model number

Western Digital WD1003FZEX

Number of drives

1

Size (TB) 1
RPM 7.2K
Type SATA 6.0

Ethernet adapters

Vendor and Model Number

Intel Ethernet Controller X540-AT2

Type

Integrated

Ethernet adapter 2

Vendor and Model Number

Qlogic® QLE2562

Type

PCle

Figure 14: System configuration information for our test server.
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APPENDIX D — HOW WE TESTED

Equipment
# of M
Server name 0 Model Processors emory Functional role
servers (GB)
Intel server 1 $2600WT 2 X Intel Xeon E5-2680 v3 256 ?:Lrj‘_’r‘;r Under Test
Infrastructure 4 Intel-based 2 X Intel Xeon E5-2650 v3 192 Infrastructure
servers server

Figure 15: Detailed server specifications.

For our virtualized test, we installed and configured the latest available version of VMware vSphere 6.0 on the
infrastructure servers and on the Intel server under test. For our bare metal configuration, we installed a copy of
Windows Server 2012 R2 on the Intel server under test.

We used two 10GbE switches to provide connectivity between infrastructure servers, server under test, and
storage, and we used two 10GbE ports for networking per server. We used one port for server management and to carry
private test traffic, and we used the second port to connect to the storage.

For storage, we used an industry-leading SSD-based storage array and provisioned a 10TB datastore for the

server under test to use.

Configuring the server under test for Intel Node Manager
1. Connect network cable to mgmt NIC.
Power on the server and press F2 to enter Server Setup.
Select Server Management — BMC LAN Configuration.
Select User Configuration.
Select User ID root.
If necessary, change User Status to enabled.
Select User Password and enter a secure password.
Hit ESC to return to previous menu.
Under IPv6, select Disabled.
. Under DHCP hostname, enter decmintelhost1.

W o N Uk WN

I
= O

. Under User Configuration, select User ID and select root.

=
N

. Under User Status, select Enabled.

[EEN
w

. Under User Password, enter a secure password.

=
S

. Press F10 to save configuration.

15. Hit ESC three times to exit menu and select Reset to reboot the server.
Installing Intel Data Center Manager software

1. Double-click the installation program.

2. At the welcome screen, click Next.

3. Inthe license agreement, choose | accept the terms. Click Next.

Improve datacenter energy efficiency with Intel Node Manager A Principled Technologies report 14
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Enter customer information, and click Next.

Select a destination folder, and click Next.

Choose the default SNMP and RMI settings, and click Next.

Choose the default HTTPS port, and click Next.

Change the sample frequency and data granularity to 30 seconds, and click Next.

Configure the datacenter manager username and password.

10. Enter keystore password and certificate information, and click Next.

11. Select the Default embedded database, enter user credentials, and click Next.
12. Click Install.

Discovering and adding systems to Intel Data Center Manager

1.

o v kA wN

Open the browser and enter https://localhost:8643/DcmConsole/ to launch the DCM Console.

To login, enter the user name and password configured during installation.

Click Discovery and Import.

Click Add Discover Task.

Select IPMI as the protocol, and input the appropriate IP range and Subnet Mask of the server under test.

Enter root as the IPMI User Name, enter the previously selected password, and click OK to initiate the discovery
process.

Click Data Center Management and click the + sign to add a Data Center, Room, Row, Rack, and Device. The
Device should be the system recently discovered.

Applying a power cap using Intel Data Center Manager

1.

o vk wnN

Click the Devices and Racks tab.

Under Devices, select the server.

Click the Policies tab.

Click Add.

Enter a Policy name, select Custom Power Limit as the policy type, and enter a power cap in Watts.
Select Permanent Policy, and make sure that the Policy Enabled option is selected. Click OK.

Improve datacenter energy efficiency with Intel Node Manager A Principled Technologies report 15
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MIXED WORKLOAD: LOADGEN 2013 METHODOLOGY

VM name vCPUs Memory Host (o} OS drive Additional drive
Windows Server
ExchangeCAS 8 16 GB Intel SUT 2012 R2 100 GB None
Standard
Windows Server
ExchangeMB 8 16 GB Intel SUT 2012 R2 100 GB 750 GB for Mailboxes
Standard
Exchange Windows Server
AD/DNS 2 8GB Infra 2012 R2 100 GB None
Standard
Windows Server
LoadGen client 4 8 GB Infra 2008 R2 100 GB None
Enterprise

Figure 16: The virtual machines in our test environment.

Setting up Microsoft Windows Active Directory® server
1. Inyour Web browser, connect to the vSphere server.
Right-click the ESXi host, and choose New Virtual Machine.
On the Create New Virtual Machine screen, select custom, and click Next.
Assign a name to the virtual machine, and click Next.
Select the LUN for the storage, and click Next.
Select Virtual Machine Version 11, and click Next.
Choose Windows, select Microsoft Windows Server 2012, and click Next.
Choose the VM'’s virtual hardware options, and click Next.

W oo N WN

Select two virtual processor socket, and select one core per virtual socket.
. Select 4GB RAM.
. Select the NIC interface with access to the private test network.
. Leave the default option for SCSI controller.
. Choose to create a new virtual disk, and click Next.

S S )
2 W N PP O

. Make the OS virtual disk size 100 GB, choose thin provisioned, specify external storage, and click Next.

[EEN
ui

. Keep the default virtual device node (0:0), and click Next.
. Click Finish.

. Right-click the VM, and select Edit Settings.

. Click the Resources tab, and click Memory.

[ S S
O 00 N O

. Select Reserve all guest memory, and click OK.
. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2012 R2 installation disk.
21. Start the VM.

Installing Microsoft Windows Server 2012 R2 Standard Edition
1. Connect the installation media, and power on the VM.

N
o

2. When the option appears, to enter the Boot Manager, press F11.
3. Select the connected boot media, and press Enter.
4. When prompted to boot from DVD, press any key.
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13.

14.
15.

When the installation screen appears, click My language is English.

Leave language, time/currency format, and input method as default, and click Next.

Click Install now.

When the Windows Setup screen appears, when prompted to go online to install updates, click No thanks.
Select Windows Server 2012 R2 Standard (Server with a GUI), and click Next.

. Check the I accept the license terms checkbox, and click Next.
. Click Custom: Install Windows only (advanced).
. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated

Space.

Select Drive 0 Unallocated Space, and click Next. At this point, Windows will begin installing, and will restart
automatically after completing.

When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
Log in with the previously set up password.

Configuring Windows Update

1.

vk W

In the left pane of the Server Manager screen, click Local Server.

In the main frame, next to Windows Update, click Not configured.

In the Windows Update screen, in the main pane, click Let me choose my settings.

Under Important updates, select Never check for updates (not recommended), and click OK.
In the left pane, click Check for updates, and install all available updates.

Close the Windows Update screen.

Configuring Windows Firewall

1.

ok wnN

In Server Manager, click Tools>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.

In the Domain Profile tab, for Firewall state, click Off.

In the Private Profile tab, for Firewall state, click Off.

In the Public Profile tab, for Firewall state, click Off.

Click OK.

Close the Windows Firewall Properties screen.

Setting up Remote Desktop

1.
2.

In the Local Server tab of the Server Manager screen, next to Remote Desktop, click Disabled.

In the System Properties screen, in the Remote Desktop section, select the Allow remote connections to this
computer radio button. When the warning message appears, click OK.

Uncheck Allow connections only from computers running Remote Desktop with Network Level
Authentication (recommended), and click OK.

Disabling IE Enhanced Security Configuration

1.
2.

In the Local Server tab of the Server Manager screen, next to IE Enhanced Security Configuration, click On.
In the Internet Explorer Enhanced Security Configuration screen, select the Off radio buttons for both
Administrators and Users, and click OK.

Installing VMware Tools

1.

Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
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Installing Active Directory and DNS services

1. Power on the Active Directory VM.

On the Active Directory server, open Windows PowerShell.

Run the following command: Install-WindowsFeature RSAT-ADDS
When the installation is finished, close PowerShell.

On the VM, open Server Manager.

On the Welcome screen, click 2, and click Add roles and features.

At the initial Before you begin screen, click Next three times.

At the Server Roles screen, select Active Directory Domain Services.

Lo N A WN

On the pop-up screen, click Add Features.

=
o

. Click Next three times.

[y
[N

. Verify the desired role is being installed, and click Install.

[E
N

. Once installation has finished, close the Add roles and features wizard.
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. In Server Manager, click the flag at the top, and select the Promote this server to a domain controller link.

[N
D

. Select Add a new forest, enter a root domain name of test.local and click Next.
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u

. On the Domain Controller Options screen, enter a password, and click Next.
. On the DNS Options screen, click Next.
. On the Additional Options screen, click Next.
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. On the Paths screen, click Next.
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. On the Review Options screen, click Next.

N
o

. On the Prerequisites screen, verify all prerequisites have passed, and click Install.
21. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.

Creating the first VM

1.
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10.
11.

12.
13.
14.
15.
16.

Using the vSphere client, connect to the vCenter Server.

Right-click the cluster, and choose New Virtual Machine.

On the Configuration screen, choose Custom, and click Next.

On the Name and Location screen, add a name, select the datacenter, and click Next.

On the specific Host screen, choose the server under test, and click Next.

On the Storage screen, select the OS datastore on the external storage, and click Next.

On the Virtual Machine Version screen, choose Virtual Machine Version 11, and click Next.

On the Guest Operating System screen, choose Windows, select Microsoft Windows Server 2012 R2 (64-bit), and
click Next.

On the CPUs screen, choose 1 virtual socket, choose 4 virtual processors per core, and click Next.

On the Memory screen, choose 8 GB RAM, and click Next.

On the Network screen, click 1 for the number of NICs, select the NIC connected to the isolated testing network,
and click Next.

On the SCSI Controller screen, leave the default virtual storage controller, and click Next.

On the Select a Disk screen, choose to create a new virtual disk, and click Next.

On the Create a Disk screen, make the OS virtual disk size 100 GB, and choose thin provisioned.

On the Advanced Options screen, leave the default virtual device node (0:0), and click Next.

On the Ready to Complete screen, click Finish.
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17. Right click the VM, select Upgrade Virtual Hardware, and click Yes.
18. Start the VM.
19. Attach the Windows Server 2012 R2 ISO image to the VM, and install Windows Server 2012 R2 on your VM.

Installing the operating system on the VMs
Repeat the sections above regarding the initial creation of the virtual machines and installation of Windows
Server 2012 R2 Standard.

Creating a VM template
Using the vSphere Client, right click the first VM, select Template, and select Clone to Template.

On the Name and Location screen, enter a Template Name.
On the Host / Cluster screen, select the management server.
On the Datastore screen, select a datastore, and click Next.
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On the Ready to Complete screen, click Finish.
The template created will be used to clone out the rest of the VMs.

Configuring the Active Directory server

Preparing AD for Exchange
1. Create areverse lookup zone:
Click Start, and type DNS in the search field.
Open the DNS manager by clicking in the results field.
Expand your active directory domain, and click Reverse Lookup Zones.
Click Action>New Zone.
On the Welcome screen, click Next.
Chose Primary Zone, and click Next.
Leave default replication scope, and click Next.
Choose IPv4, and click Next.
Enter the IP address of your domain (192.168.3) for our example.

S@m 0 a0 T oo

j. Choose Allow both nonsecure and secure dynamic updates, and click Next.
k. Click Finish.

Insert the Exchange 2012 SP1 Installation ISO in the AD VM DVD drive.

In Windows Explorer, double-click the Exchange DVD icon.

In the Exchange installation folder, hold down shift, and right-click.

Choose Open a command window.

A T

Run the following command: Setup.exe /PrepareSchema
/IAcceptExchangeServerLicenseTerms
7. When the previous command completes, run the following command: Setup.exe /PrepareAD
/OrganizationName:”organization name” /IAcceptExchangeServerLicenseTerms
8. Close the command window when the setup finishes.
Installing Active Directory Certificate Services
1. Launch Server Manager, and select Add roles and features.
2. At the Add Roles and Features Wizard, click Next.
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14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.

Select Role-based or feature-based installation, and click Next.

Choose Active Directory Certificate Services.

If prompted, to install any required features, click Add Features.

Click Next three times.

Choose Certificate Authority and Certification Authority Web Enrollment.
If prompted, to install any required features, click Add Features.

Click Next.

. Leave defaults, and click Next.
. Click Install.
. When the install finishes, click Close.

. In the Server Manager, click the yellow warning symbol, and click Configure Active Directory Certificate

Services.

Leave defaults, and click Next.

Check both Certification Authority and Certification Authority Web Enrollment, and click Next.
Choose Enterprise CA, and click Next.

Choose Root CA, and click Next.

Choose Create a new private key, and click Next.
Leave defaults, and click Next.

Leave defaults, and click Next.

Leave 5 years, and click Next.

Leave default locations, and click Next.

Click Configure.

Close when the configuration finishes.

Open Internet Explorer and navigate to localhost/certsrv/Default.asp to verify that the installation

succeeded.

Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles

Using the template, clone two VMs, one for the Exchange Client Access Server, or CAS, and the other for the

Exchange Mailbox Server. Edit the hardware settings in each. The Mailbox server should have eight vCPUs (eight virtual

sockets each with one core) and 16 GBs of memory. Using the Exchange datastore, add a 750 GB disk and a 100 GB disk

to the Mailbox server for the Exchange mailbox and Exchange logs respectively. Set static IPs on both VMs and join the

domain.
1.
2.

On the Exchange Mailbox Server, log into the server using domain administrator credentials.
Open Windows PowerShell and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-
Framework-45-Features, RPC-over-HTTP-proxy, RSAT-Clustering, RSAT-
Clustering-CmdInterface, RSAT-Clustering-Mgmt, RSAT-Clustering-
PowerShell, Web-Mgmt-Console, WAS-Process-Model, Web-Asp-Netd5, Web-
Basic-Auth, Web-Client-Auth, Web-Digest-Auth, Web-Dir-Browsing, Web-Dyn-
Compression, Web-Http-Errors, Web-Http-Logging, Web-Http-Redirect, Web-
Http-Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-Mgmt-Console,
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Web-Metabase, Web-Mgmt-Console, Web-Mgmt-Service, Web-Net-Ext45, Web-
Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content,
Web-Windows-Auth, Web-WMI, Windows-Identity-Foundation

3. Restart the server.

Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit.
(go.microsoft.com/fwlink/p/?linkld=258269)

Run UcmaRuntimeSetup.exe.

When the installation completes, click Finish.

Navigate to the location of the Exchange installation media, and double-click Setup.exe.
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At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and
click Next.

9. When the updates complete, click Next.

10. At the Introduction screen, click Next.

11. At the License Agreement screen, check the box to accept the terms, and click Next.

12. At the Recommended Settings screen, check the Don’t use recommended settings checkbox, and click Next.
13. At the Server Role Selection, select Mailbox or Client Access role, and click Next.

14. At the Installation Space and Location screen, leave the default location for the installation, and click Next.
15. At the Malware Protection Settings, select yes to disable, and click Next.

16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.

17. When the installation completes, click Finish, and restart the server.

18. Repeat steps 1-17 for the Exchange CAS server.

Configuring Exchange
1. On the CAS server, open the Exchange Admin Center by using a browser and navigating to
https://localhost/ecp
Enter the domain administrator credentials, and click Sign in.
If prompted, select the language and time zone, and click Save.
In the left pane, click Mail flow, and click Send connectors.
On the Send connectors page, click the New icon.
In the New send connector wizard, specify SMTP as the name, and select Internet as the type. Click Next.
In the Network settings screen, choose MX record associated with recipient domain, and click Next.

In the Address space screen, click the Add icon.
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In the Add domain screen, in the Fully Qualified Domain Name (FQDN) field, enter *, and click Save.
. Click Next.

. In Source server screen, click the Add icon.

[
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. In the Select a Server screen, select the mailbox server, click Add, and click OK.
. Click Finish.

. In the left pane of the EAC, click servers, select the name of the CAS server, and click Edit.
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oA W

. Click Outlook Anywhere, and for the external and internal hostname field, enter the appropriate FQDN of

the Client Access Server. (For example, exchangeserver.test.local.)
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16.
17.
18.
19.
20.
21.

22.
23.

Choose NTLM as the authentication method, and click Save.

Click Virtual Directories, and click the Configure external access domain icon.

In the Select the Client Access servers to use with the external URL screen, click the Add icon.

Select the CAS server, and click Add. Click OK.

Type the FQDN of the CAS server in the Enter the domain field, and click Save.

Log into the Active Directory server using administrator credentials, and complete the following steps:
a. Open Server Manager, and click Tools=>DNS
b. Inthe left pane of DNS Manager, expand the Active Directory server name—>Forward Lookup

Zones—>test.local.

c. Inthe right pane of DNS Manager, verify or create the DNS records as presented in Figure 17.

Host or child FQDN of mail

Type domain/alias name AoplE server
Mail Exchanger (MX) | Leave blank domain.com casserver.domain.com
Alias (CNAME) Autodiscover Autodiscover.domain.com | casserver.domain.com
Alias (CNAME) Owa Owa.domain.com casserver.domain.com

Figure 17: DNS records.

Log into your CAS server.
In the Exchange Power Shell, run the following commands, replacing “SHostName” with the host name (not

FQDN) of your CAS server.

Set-EcpVirtualDirectory "SHostName\ECP (Default Web Site)" -InternalUrl
((Get-EcpVirtualDirectory "SHostName\ECP (Default Web
Site)") .ExternalUrl)

Set-WebServicesVirtualDirectory "S$HostName\EWS (Default Web Site)" -
InternalUrl ((get-WebServicesVirtualDirectory "S$HostName\EWS (Default Web
Site)") .ExternalUrl)

Set-ActiveSyncVirtualDirectory "S$SHostName\Microsoft-Server-ActiveSync
(Default Web Site)" -InternalUrl ((Get-ActiveSyncVirtualDirectory
"SHostName\Microsoft-Server-ActiveSync (Default Web Site)") .ExternalUrl)

Set-0OabVirtualDirectory "S$SHostName\OAB (Default Web Site)" -InternalUrl
((Get-OabVirtualDirectory "S$HostName\OAB (Default Web
Site)") .ExternalUrl)

Set-OwaVirtualDirectory "S$HostName\OWA (Default Web Site)" -InternalUrl
((Get-OwaVirtualDirectory "S$SHostName\OWA (Default Web
Site)") .ExternalUrl)

Set—-PowerShellVirtualDirectory "S$HostName\PowerShell (Default Web Site)"
-InternalUrl ((Get-PowerShellVirtualDirectory "S$HostName\PowerShell
(Default Web Site)") .ExternalUrl)

Get-0OfflineAddressBook | Set-OfflineAddressBook -
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25.
26.
27.
28.
29.
30.
31.
32.
33.
34.

35.
36.
37.
38.
39.
40.

41.

42.
43.
44,
45.
46.
47.

48.
49.

50.
51.
52.
53.
54.

GlobalWebDistributionEnabled $True -VirtualDirectories $Null

Create a folder at the root of C: on the CAS server, and share it to Everyone with read/write permissions.
Log into the Exchange admin center, and navigate to Servers—> Certificates.

Choose the CAS server in the drop-down menu, and to create a new certificate, click the plus sign.
Choose Create a request for a certificate from a certification authority, and click Next.

Name the certificate, and click Next.

Do not request a wildcard certificate, and click Next.

Click Browse, choose the CAS server, and click Ok. Click Next.

Leave defaults, and click Next.

Leave defaults, and click Next.

Enter your organization information, and click Next.

Enter the path to the share you created on the CAS server, and click Finish. Example:
\\cas\share\myrequest.REQ

Log into the AD server, and open Internet Explorer.

Browse to localhost/CertSrv

Click Request a certificate.

Choose Advanced certificate request.

Choose Submit a certificate request by using a base-64-endcoded CMC.

Open Windows Explorer, and navigate to the share folder on the CAS server where the certificate request is
stored.

Open the certificate with notepad, and copy the content between BEGIN NEW CERTIFICATE REQUEST and
END NEW CERTIFICATE REQUEST.

Paste the copied content into the Saved Request screen.

In the Certificate Template drop-down menu, choose Web Server, and click Submit.

Choose Base 64 encoded, and download the certificate.

Copy the new certificate into the share folder on the CAS server.

Log back into the CAS server and open the Exchange Admin Center.

Go to Servers—>Certificates, and highlight the certificate you began before. (In the status column, it should
say Pending request.)

Click Complete on the right side.

Type the path to the certificate, including the certificate name, and click Ok. Example:
\\cas\share\certnew.CER

Verify that the status has changed to Valid.

Edit the new entry, and click Edit.
Go to Services and check SMTP and IS, and click Save.
On the warning message, click Yes.
Run the following steps on the CAS and AD servers.
a. Click Start, and type MMC
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55.
56.
57.
58.

59.
60.

61.
62.

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates=>Trusted Root Certificate Authorities—=> Certificates.

Click Action=>All Tasks=>Import.

Click Next.

j. Browse to the share folder on the CAS server, and choose the new certificate you created. Click
Next.

k. Leave defaults, and click Next.

I.  Click Finish.

m. Click OK on the Import was successful message.
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Log into the CAS server, and open the Exchange admin center.

Navigate to Servers—>Databases.

Restart the Microsoft Exchange Information Store service on the MB server.

Using the Edit button, disable the maintenance schedule, and enable circular logging for each mailbox
database.

Dismount and remount the databases.

Open Exchange Management shell, and enter the following to move the paths of the default mailbox:
Move-Databasepath “DatabaseName” -EdbFilepath “E:\Newlocation\DBname.edb”
-LogFolderpath “F:\Newlocation”

When prompted, type A and press enter.

Open Exchange Management Shell, and enter the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname cas.domain.com
-DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl S$true

Installing and configuring the Exchange 2013 mail test clients and completing LoadGen
configuration on Exchange 2013

For our testing, we used one virtual client machine to run Loadgen2013. To create the mail clients, we installed

several software components. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition

1.
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Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms checkbox, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.
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10.
11.
12.
13.
14.

At the Your password has been changed screen, click OK.

Click Start, type change power-saving settings and press Enter.

Click Change plan settings.

Change the Turn off the display drop-down menu to Never.

Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail

the necessary installation processes.

Joining the domain

1.
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10.

11.

12.
13.

Set a static IP.

Select Start—>Control Panel>Network Connections—>Local Area Connection.

Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

Select the Use the following DNS server addresses radio button, and in the Preferred DNS server field, enter
the IP of the DNS server. Click OK.

Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.

In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and
type test.local

Select OK to start joining the domain.

When the screen appears asking for a person qualified on the domain, type Administrator as the
username and Passwordl as the password.

At the Welcome pop-up and the screen warning that you must restart the computer for the changes to take
effect, click OK.

At the System Properties screen, click OK.

When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services

1.
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13.
14.

Click Start->Administrative Tools—>Server Manager.

On the left pane, click Roles.

Click Add Roles.

Click the Application Server checkbox.

When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next.

Click Next.

At the Select Role Services page for Application Server, click the Web Server (11S) Support checkbox.
Click Add Required Support Role Services.

. Click Next.
. Click Next.
. At the Select Role Services page for Web Server (l1S), click IS 6 Management Compatibility, ASP, and CGI

checkboxes, and click Next.
Click Install.
Click Close.
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Installing Load Generator

Download and install Load Generator 2013 using all defaults.

Importing
1.
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15.

16
Preparing
1.
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10.

11.

12.

13.
14.

the certificate and editing the hosts file
Click Start, and type MMC

Click File>Add/Remove Snap-in.
Choose Certificates, and click Add.
Choose Computer account, and click Next.
Choose Local computer, and click Finish.
Click OK.
Expand Certificates>Trusted Root Certificate Authorities—=> Certificates.
Click Action—=>All Tasks=> Import.
Click Next.
. Browse to the share folder on the CAS server, and choose the new certificate you created. Click Next.
. Leave defaults, and click Next.
. Click Finish.
. Click OK on the Import was successful message.
. Open the Notepad program, and use File>Open to open the hosts file stored at
C:\Windows\System32\drivers\etc.
Add the IP and FQDN of the CAS server.
. Save and close Notepad.

Load Generator
Log into the mail client.

Select Start—=>All Programs—> Microsoft Exchange—> Exchange Load Generator 2013.

When the Load Generator screen appears, select Start a new test.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to 12 hours.

In the Specify test settings screen, type Password]l as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

Create 2,000 users in the Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups screen, select the plus sign to add a user group.

Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_300, and the Mailbox size to
250 MB, and click Continue.

In Remote configurations, check the checkbox to enable distributing the workload, enter the computer
names of all of the test clients, and click Continue.

Click Save the configuration file as, and name it testcfg.xml

Click Start the initialization phase (recommended before running the test).

Once you have initialized the database, create a backup copy of the Exchange mailbox databases.

Improve

datacenter energy efficiency with Intel Node Manager A Principled Technologies report 26



Running the LoadGen test
To run the test, we installed the LoadGen client and server components and simulated 2,000 Exchange users

targeting the Exchange VM using LoadGen’s Exchange 300 Workload profile. We ran the LoadGen benchmark for 30
minutes.

For more details about LoadGen, see www.microsoft.com/download/en/details.aspx?displaylang=en&id=14060.

STORAGE-INTENSIVE WORKLOAD: DVD STORE METHODOLOGY

For DVD store testing, we installed a fresh copy of Windows Server 2012 R2 on the server under test. We also
installed SQL Server 2014 and deployed four SQL instances, each with a 100GB database. We ran the test for 45 minutes
using a .05 millisecond think time.

Installing Microsoft Windows Server 2012 R2 Datacenter Edition
1. Insert the installation media into the CD/DVD drive, and restart the server.
When the option appears, to enter the Boot Manager, press F11.
Select BIOS Boot Menu.
Select SATA Optical Drive, and press Enter.
When prompted to boot from DVD, press any key.
When the installation screen appears, click My language is English (United States).
Leave language, time/currency format, and input method as default, and click Next.

Click Install now.
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When the installation prompts you, enter the product key.
. Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.
. Check | accept the license terms, and click Next.
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. Click Custom: Install Windows only (advanced).
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. Select Drive 0 Unallocated Space, and click Next. At this point, Windows begins automatically and restarts
automatically after completing.

14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.

15. Log in with the password you set up previously.

Configuring Windows Update
1. Inthe left pane of the Server Manager screen, click Local Server.
In the main frame, next to Windows Update, click Not configured.
In the Windows Update screen, in the main pane, click Let me choose my settings.
Under Important updates, select Never check for updates (not recommended), and click OK.

In the left pane, click Check for updates, and install all available updates.
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Close the Windows Update screen.

Installing SQL Server 2014
1. Insert the installation DVD for SQL Server 2012 into the DVD drive.
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12.
13.
14.

15.

16.
17.
18.
19.
20.

21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and
double-click it.

In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.

Select the Enter the product key radio button, and enter the product key. Click Next.

Click the checkbox to accept the license terms, and click Next.

Click Use Microsoft Update to check for updates, and click Next.

Click Install to install the setup support files.

If no failures are displayed, click Next.

. At the Setup Role screen, choose SQL Server Feature Installation, and click Next.

. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for

Search, Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and
Management Tools — Complete. Click Next.

At the Installation Rules screen, after the check completes, click Next.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Server Configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose
NT Service\MSSQLSERVER for SQL Server Database Engine. Change the Startup Type to Automatic. Click
Next.

At the Database Engine Configuration screen, select the authentication method you prefer. (For our testing
purposes, we selected Mixed Mode.)

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Close the installation screen.

Navigate to the SQL Server 2014 DVD, and double-click it.

In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.

At the Installation Type screen, select Perform a new Installation of SQL Server 2014. Click Next.

Select the Enter the product key radio button, and enter the product key. Click Next.

Click the checkbox to accept the license terms, and click Next.

At the Setup Role screen, select SQL Feature Installation. Click Next.

At the Feature Selection screen, select Database Engine Services and Full-Text and Semantic Extractions for
Search. Click Next.
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32. At the Instance Configuration screen, select named instance, and enter a name. Click Next.

33. At the Server Configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose
NT Service\MSSQLSERVER for SQL Server Database Engine. Change the Startup Type to Automatic. Click
Next.

34. At the Database Engine Configuration screen, select the authentication method you prefer. For our testing
purposes, we selected Mixed Mode.

35. Enter and confirm a password for the system administrator account.

36. Click Add Current user.

37. Click Next.

38. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

39. At the Ready to Install screen, click Install.

40. After installation completes, click Close.

41. Repeat steps 4 - 40 to install three more SQL instances.

Configuring the database

We generated the database data using the Install.pl script included with DVD Store version 2.1 (DS2), providing
the parameters for our 100GB database size and the database platform on which we ran Microsoft SQL Server. We ran
the Install.pl script on a utility system running Linux. The Install.pl script generated the database schema.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server. We built the 100GB database in SQL Server, and we performed a full backup, storing
the backup file remotely for quick access. We used that backup file to restore the server between test runs.

The only modifications we made to the schema creation scripts were the specified file sizes for our database. We
explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
test. Other than this file size modification, we created and loaded the database in accordance with the DVD Store
documentation. Specifically, we followed these steps:

1. We generated the data, and created the database and file structure using database creation scripts in the
DS2 download. We made size modifications specific to our 100GB database, and made the appropriate
changes to drive letters.

We transferred the files from our Linux data generation system to a Windows system running SQL Server.
We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.
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We loaded the data we generated into the database. For data loading, we used the import wizard in SQL
Server Management Studio. Where necessary, we retained options from the original scripts, such as Enable
Identity Insert.

We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.
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8. Onthe SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:
USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
DEFAULT DATABASE=[master],
DEFAULT LANGUAGE=[us english],
CHECK EXPIRATION=OFF,
CHECK POLICY=O0OFF
GO
9. We set the database recovery model back to full.
10. We created the necessary full text index using SQL Server Management Studio.
11. We created a database user, and mapped this user to the SQL Server login.
12. We performed a full backup of the database. This backup allowed us to restore the databases to a pristine

state relatively quickly between tests.

Running the DVD Store tests

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store

outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report

the last OPM reported by each client/target pair.
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Each complete test cycle consisted of the following general steps:

Clean up prior outputs from the target system and the client driver system.

Drop the database from the target.

Restore the database on the target.

Shut down the target.

Reboot the host and client system.

Wait for a ping response from the server under test (the hypervisor system), the client system, and the target.
Let the test server idle for 20 minutes.

Start the DVD Store driver on the client.

We used the following DVD Store parameters for testing:

ds2sglserverdriver.exe --target=<target IP> --ramp rate=10 --run time=60 --
n threads=32 --db size=100GB --think time=0.05 --detailed view=Y --warmup time=5
-—csv_output=<drive path>

MEMORY-INTENSIVE WORKLOAD: SPECJJIB METHODOLOGY

SPECjbb2005 requires Java Runtime Environment to run. We used Oracle HotSpot 64-bit server with Java version

1.7.0_65 for testing. We used the following steps to install Java.
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Installing Java

1. Download Java installation file from https://java.com/en/download/.

Double click the installation file.

At the Welcome screen, select Change destination folder and click Install.
At destination folder, click Change.

Navigate to C: and click Make folder. Name the folder Java, and click Ok.
Click Next.

When the installation finishes, click Close.

Installing SPECjbb2005

The SPECjbb2005 benchmark has a main folder that must be copied over to the server under test. We copied
this folder to the test server and put in C:\SPECjbb2005. We used SPECjbb2005 version 1.07 for testing.

For testing, we used four Java instances. We started the test with the default runit_multi. bat file in the
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SPECjbb2005 directory. However, we used the following Java Options:

-Xmx64g -Xms64g -Xmn50g -XX:+UseParallelOldGC
-XX:-UseAdaptiveSizePolicy -XX:-UseBiasedLocking

CPU-INTENSIVE WORKLOAD: VDI TESTING METHODOLOGY

On the infrastructure servers, we installed and configured VMware View Horizon 6.0 to use a VMware vCenter
and VMware Composer Server. We created one automated, floating, linked clone pool, and configured the pool to use 1

GB of host cache. We configured the linked clones with two vCPUs and 1.5 GB of memory.
Configuring the VMs and storage

VM name Qty. oS Role Host(s) vCPUs | Mem (GB) | vDisk (GB)
Windows 2008 Active Directory, DNS,
DC1 1 R2 DHCP Infrastructure p 4 100
VSI_Share 1 \é\/zlndows 2008 Login VSI share Infrastructure 2 4 100
vCenter 1 \é\/zlndows 2008 VMware vCenter Infrastructure 4 8 100
Composer 1 \F:\;lndows 2008 VMware Composer Infrastructure 2 8 100
View 1 \F:\;lndows 2008 VMware View server Infrastructure 2 4 100
saL 1 Windows 2008 vCenter, and Composer DB Infrastructure 5 4 100
R2 server
LO1-l06 6 Windows 7 (x64) | Login VSI Launcher Infrastructure 2 8 40
View VMs 150 Windows 7 (x86) | VMware Virtual Desktops Intel SUT 2 1.5 24

Figure 18: Detailed VM configuration.

We used the Login VSI 4.1 Knowledge Worker workload to generate a reproducible, real-world test case against

the virtual desktops pool. This workload simulated the execution of various applications, including Microsoft® Internet

Improve datacenter energy efficiency with Intel Node Manager A Principled Technologies report 31


https://java.com/en/download/

Explorer®, Microsoft Office applications, and high definition videos. Using Login VSI, we could determine how many
virtual desktop users each solution could support.

We configured Login VSI to run in benchmark mode to create a default test environment in which we could
compare test results with each other. Login VSI measures the total response time of multiple operations from each
session, and at the beginning of each test, it samples a small set of virtual desktops to generate a VSImax Baseline. As
more sessions begin to consume system resources, response time degrades, and the VS| response time increases until it
reaches VSImax. VSImax is reached when the average VS| response time result reaches VSlbase + a 1000 ms latency
threshold. When this condition is met, the benchmark records a Login VSImax, which is the maximum number of
sessions that platform could support. Not reaching VSImax is an indication of good end user response time. For more

information about VSImax, see www.loginvsi.com/documentation/index.php?title=VSImax

Installing VMware ESXi 6.0 on the infrastructure servers and server under test
1. Attach the installation media.

Boot the server.

At the VMware Installer screen, press Enter.

To Accept and Continue at the EULA screen, press F11.

Under Storage Devices, select the appropriate virtual disk, and press Enter.

Select US as the keyboard layout, and press Enter.

Enter the root password twice, and press Enter.

Press F11 to start installation.
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After the server reboots, press F2 and enter root credentials.
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. Select Configure Management Network, and press Enter.
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. Select the appropriate network adapter, and select OK.
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. Log into the server using the VMware vSphere client.
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. Select the Configuration tab, and click Networking.
. Click Add Networking.

. Create the management network.

[ SO Y
o U b

. To configure server time, click the Configuration tab, and select Time Configuration.

17. Click DNS and Routing, and confirm the settings.

Setting up a VM to host the Microsoft Windows Active Directory® server (DC1)
1. Connect to the infral server via the VMware vSphere client.

Loginas root

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

Choose Custom, and click Next.

Assign the name DC1 to the virtual machine, and click Next.

Select infral as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 11, and click Next.

Choose Windows, choose Microsoft Windows Server® 2008 R2 (64-bit), and click Next.
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10. For CPUs, select one virtual processor socket and two cores per virtual socket, and click Next.

11. Choose 4 GB RAM, and click Next.

12. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.

13. Leave the default virtual storage controller, and click Next.

14. Choose to create a new virtual disk, and click Next.

15. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.

16. Keep the default virtual device node (0:0), and click Next.

17. Click Finish.

18. Right-click the VM, and choose Edit Settings.

19. Click the Resources tab, and click Memory.

20. Select Reserve all guest memory, and click OK.

21. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.

22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open avirtual machine console on DC1.

Choose the language, time and currency, and keyboard input. Click Next.

Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—>Apply—>Format, and click Next.

After the installation completes, to set the Administrator password, click OK.
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. Enter the administrator password twice, and click OK.
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. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to DC1, and reboot when the installation prompts you.
16. Set up networking for the data network:

a. Click Start->Control Panel, right-click Network Connections, and choose Open.

b. Right-click the VM traffic NIC, and choose Properties.

Uncheck TCP/IP (v6).
d. Select TCP/IP (v4), and choose Properties.
e. SetthelPaddressas172.16.0.10/255.255.0.0
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Installing Active Directory and DNS services on DC1
1. Click Start->Run, type dcpromo, and click OK.
2. Atthe Active Directory Domain Services Installation Wizard welcome screen, check the Use advanced mode
installation option, and click Next.
3. Inthe Choose a Deployment Configuration dialog box, select Create a new domain in a new forest, and click
Next.
At the FQDN page, type domain.local, and click Next.

At the NetBIOS name prompt, leave the name domain, and click Next.

4
5
6. Atthe Forest Functionality level, select Windows Server 2008 R2, and click Next.
7. At the additional Domain Controller Options, leave DNS server selected, and click Next.
8. Assign a Directory Services Restore Mode Administrator account password, and click Next.
9. Atthe Summary screen, review your selections, and click Next.

10. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.
11. Click Start>Run, and type dnsmgmt .msc

12. Create a reverse lookup zone for DC1.

13. Create static entries for the three infrastructure servers and the five servers under test.

Configuring the Windows time service on DC1

To ensure reliable time, we pointed our Active Directory server to a physical NTP server.

1. Openacommand prompt.
2. Type the following:
W32tm /config /syncfromflags:manual /manualpeerlist:"<ip address of a NTP
server>"
W32tm /config /reliable:yes
W32tm /config /update
W32tm /resync
Net stop w32time
Net start w32time

Setting up DHCP services on DC1
1. Click Start->Administrative Tools—>Server Manager—>Add Roles.
Select DHCP Server, and click Next.
At the Introduction to DHCP Server screen, click Next.
At the Specify IPv4 DNS Settings screen, type domain. local for the parent domain.

Enter the preferred DNS server IPv4 address, and click Next.
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At the Specify IPv4 WINS Server Settings screen, select WINS is not required for applications on the network, and
click Next.

At the Add or Edit DHCP Scopes screen, click Add.

At the Add Scope screen, enter the Name DHCP Scope name.
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9. Inthe next box, set the following values, and click OK.
e Start IP address=172.16.2.1
e End IP address=172.16.100.200
e Subnet mask=255.255.0.0
10. Check Activate This Scope.
11. At the Add or Edit DHCP Scopes screen, click Next.
12. Click Enable DHCP v6 Stateless Mode, and click Next.
13. Leave the default IPv6 DNS Settings, and click Next.
14. At the Authorize DHCP server dialog box, select Use current credentials.
15. At the Confirm Installation Selections screen, click Next. If the installation is set up correctly, a screen displays
saying the DHCP server install succeeded.
16. Click Close.

Setting up a VM to host the vCenter server (vCenter)
1. Loginto the infral server with the VMware vSphere client.

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

Choose Custom, and click Next.

Assign the name vCenter to the virtual machine, and click Next.

Select infral as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.
. Choose 8GB RAM, and click Next.
. For the number of NICs, click 1; select VMXNET3; connect to the PRIV-NET port group; and click Next.
. Leave the default virtual storage controller, and click Next.
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. Keep the default virtual device node (0:0), and click Next.

. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

. Click Finish.

. Right-click the vCenter VM, and click Edit settings.

. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
18. Start the VM.
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Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open avirtual machine console on vCenter.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.
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Click the Disk, and click Drive options (advanced).
Click New—>Apply—>Format, and click Next.
After the installation completes, to set the Administrator password, click OK.
10. Enter the administrator password twice, and click OK.
11. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

14. Enable remote desktop access.
15. Change the hostname to vCenter, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start, click Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
c. Uncheck the TCP/IP (v6) checkbox.
d. Select TCP/IP (v4), and choose Properties.
e. Setthe IP address, subnet, gateway, and DNS server.
17. Join the domain.local domain.

18. Reboot the system.

Setting up a VM to host Microsoft SQL Server (SQL) for infrastructure
1. Connect to the infral server via the VMware vSphere client.

Loginas root

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

Choose Custom, and click Next.

Assign the name SQL to the virtual machine, and click Next.

Select infral as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 11, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
. For CPUs, select one virtual processor socket, select two cores per virtual socket, and click Next.
. Choose 4 GB RAM, and click Next.
. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.

. Leave the default virtual storage controller, and click Next.
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. Choose to create a new virtual disk, and click Next.
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. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.

16. Keep the default virtual device node (0:0), and click Next.

17. Click Finish.

18. Right-click the VM, and choose Edit Settings.
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19.
20.
21.
22.

Click the Resources tab, and click Memory.

Select Reserve all guest memory, and click OK.

Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1.
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12.
13.
14.
15.
16.

Open a virtual machine console on SQL.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—=>Apply—> Format, and click Next.

After the installation completes, to set the Administrator password, click OK.

. Enter the administrator password twice, and click OK.

. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

Reboot the server.
Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
Enable remote desktop access.
Change the hostname to SQL, and reboot when the installation prompts you.
Set up networking for the data network:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.
Uncheck the TCP/IP (v6) checkbox.
Select TCP/IP (v4), and choose Properties.
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Set the IP address, subnet, gateway, and DNS server.

Installing Microsoft SQL Server 2008 R2

1.
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Insert the installation media, and to install .NET framework, click OK.

Wait for the SQL Installer to launch. On the left menu, click Installation.

Click New installation or add features to an existing installation. Click OK.

Enter the Product Key, and click Next.

Check the I accept the license terms checkbox, and click Next.

To install the Setup Support Files (required), click Install.

Resolve any issues displayed in the setup wizard, and click Next.

At the Setup Role screen, select SQL Server Feature Installation, and click Next.

Select Database Engine Services, Full-Text Search, Client Tools Backwards Compatibility, and Management Tools

Basic and Complete, and click Next twice.
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10. Accept instance configuration defaults, and click Next.

11. Accept defaults for disk space requirements, and click Next.

12. Click Use the same account for all SQL Server services, select NT Authority\System, and click OK. Click Next.
13. Select Mixed Mode, and enter a password for the SA account. Click Add Current User, and click Next.

14. Accept defaults for error reporting, and click Next.

15. Review installation configuration rules check, and click Next.

16. To begin the installation, click Install.

17. At the completion screen, click Close.

18. Run Windows Update to receive all updates and security patches.

Setting up databases for vCenter and VMware View™ Composer
1. LogontoSQLas DOMAIN\administrator

2. From the server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration Tools=>SQL
Server Configuration Manager.

Click SQL Server Network Configuration—>Protocols for MSSQLSERVER.

Right-click TCP/IP, and select Enabled.

Click SQL Services, right-click SQL Server Browser, and select Properties.
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In the SQL Server Browser Properties, select the Services tab, change the Start mode to Automatic, and click OK.
Repeat this step for the SQL Server Agent service.

Start the SQL Server Browser service and the SQL Server Agent service.

From the SQL Server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration
Tools=>SQL Server Management Studio.

9. Click Connect.

10. Select the Databases folder, right-click, and select New Database.

11. Provide the name vCenter for the new database.

12. Select the Databases folder, right-click, and select New Database.

13. Provide the name composer for the new database.

14. Click Options, change the recovery model from full to simple, and click OK.

Setting up an ODBC DSN on vCenter
1. LogintovCenteras DOMAIN\administrator

Click Options, change the recovery model from full to simple, and click OK.

From the desktop of the vCenter server, select Start, Run, and type odbcad32.exe. Press Enter.
Click the system DSN tab.

Click Add.

Click SQL Server Native Client 10.0, and click Finish.

In the Create a New Data Source to SQL Server text box, type the connection name vcenter

For Server, select SQL, and click Next.
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Change authentication to With SQL Server authentication using a login ID and password entered by the user,

type sa as the Login ID, use the password you defined in SQL Server setup for the SA account, and click Next.
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10. From the pull-down menu, select Change the default database to choose vCenter, and click Next.
11. Click Finish.

12. To confirm correct configuration, click Test Data Source...

13. To create the vCenter ODBC connection, click OK.

Installing VMware vCenter 6.0
1. LogintovCenteras DOMAIN\administrator

From the VMware vCenter 6 install media, click Autorun.

To start the install wizard, click Run.

Select vCenter Server for Windows, and click Install.

At the Install wizard welcome screen, click Next.

Accept the End User License Agreement, and click Next.

Select embedded deployment and the deployment type, and click Next.
Verify the system name, and click Next.

L XN Uk WwN

Enter and confirm the password you wish to use with the Administrator account for vCenter Single Sign On, and
click Next.
10. Select Use Windows Local System Account and the service account, and click Next.
11. Select Use an external database, and enter database credentials. Click Next.
12. At the Configure Ports screen, click Next.
13. Accept the default installation path, and click Next.
14. Click Install.
15. Using the vSphere web client, log into the vCenter server as DOMAIN\administrator
16. Right-click the root of vCenter, and click New Data center.
17. Name the new datacenter datacenter
18. Add the servers under test and infrastructure servers to the datacenter.
Setting up a VM to host VMWare View Composer
1. Loginto vCenter via the VMware Web client.
Click the Virtual Machines tab.
Right-click, and choose New Virtual Machine.
Select Create a new virtual machine.
Choose Custom, and click Next.
Assign the name composer to the virtual machine, and click Next.
Select infral as the host, and click Next.

Select the appropriate storage, and click Next.
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Choose Virtual Machine Version 11, and click Next.
. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
. For CPUs, select one virtual processor socket, select four cores per virtual socket, and click Next.
. Choose 8GB RAM, and click Next.
. For the number of NICs, click 1; select VMXNET3; connect to the PRIV-NET port group; and click Next.
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14. Leave the default virtual storage controller, and click Next.

15. Keep the default virtual device node (0:0), and click Next.

16. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

17. Click Finish.

18. Right-click the composer VM, and click Edit settings.

19. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
20. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open avirtual machine console on the composer VM.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New=>Apply=>Format, and click Next.

After the installation completes, to set the Administrator password, click OK.
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. Enter the administrator password twice, and click OK.
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. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

14. Enable remote desktop access.

15. Change the hostname to composer, and reboot when the installation prompts you.
16. Set up networking for the data network:

Click Start, click Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.

Uncheck the TCP/IP (v6) checkbox.

Select TCP/IP (v4), and choose Properties.

Set the IP address, subnet, gateway, and DNS server.
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17. Join the domain.local domain.
18. Reboot the system.

Setting up a database and ODBC DSN for VMware View Composer
1. Logontothe composer VM as DOMAIN\administrator

From the desktop of the vCenter server, select Start, select Run, type odbcad32.exe and press Enter.
Click the system DSN tab.

Click Add.

Click SQL Server Native Client 10.0, and click Finish.
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In the text box named Create a New Data Source to SQL Server, type the connection name composer
For Server, select SQL, and click Next.
Change authentication to With SQL Server authentication using a login ID and password entered by the user,
type sa as the Login ID, use the password you defined in SQL Server setup for the SA account, and click Next.
9. Select Change the default database to:, choose composer from the pull-down menu, and click Next.
10. Click Finish.
11. To confirm correct configuration, click Test Data Source...
12. To create the Composer ODBC connection, Click OK.

Setting up VMware Horizon View Composer 6
1. Open the View 5 media folder, and run the file named VMware-viewcomposer-6.0.1

At the Welcome screen and the Patents screen, click Next.
Accept the VMware end user license agreement, and click Next.

Leave the Destination folder as default, and click Next.
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In the Database information box, type composer as the source name and sa as the user name. Enter the
password, and click Next.
6. Leave the default SOAP port, and click Next.
7. Click Install, and click Finish.
8. Restart the server.
Setting up a VM to host the VMware View connection server
1. Loginto vCenter via the VMware Web client.
Click the Virtual Machines tab.
Right-click, and choose New Virtual Machine.
Select Create a new virtual machine.
Choose Custom, and click Next.
Assign the name View to the virtual machine, and click Next.
Select infrastructure for the host, and click Next.

Select the appropriate storage, and click Next.

© © N Uk WwWwN

Choose Virtual Machine Version 11, and click Next.
. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
. For CPUs, select one virtual processor socket, select two cores per virtual socket, and click Next.
. Choose 4GB RAM, and click Next.
. For the number of NICs, click 1; select VMXNET 3; connect to the PRIV-NET port group; and click Next.
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. Leave the default virtual storage controller, and click Next.
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. Choose to create a new virtual disk, and click Next.
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. Make the OS virtual disk size 100 GB, choose thick-provisioned lazy zeroed, specify the OS datastore on the
external storage, and click Next.

17. Keep the default virtual device node (0:0), and click Next.

18. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
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19. Right-click the View Connection VM, and click Edit settings.

20. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
21. Click Finish.

22. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open a virtual machine console on the View VM.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—=>Apply—>Format, and click Next.
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After the installation completes, to set the Administrator password, click OK.

=
o

. Enter the administrator password twice, and click OK.
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. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

14. Enable remote desktop access.

15. Change the hostname to View, and reboot when the installation prompts you.

16. Set up networking for the data network:

Click Start, click Control Panel, right-click Network Connections, and choose Open.
Right-click the VM traffic NIC, and choose Properties.

Uncheck the TCP/IP (v6) checkbox.

Select TCP/IP (v4), and choose Properties.

Set the IP address, subnet, gateway, and DNS server.

17. Join the VDI domain.

18. Reboot the system.
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Installing the VMware View Connection Server 6
Log into the server named View Connection.

=

Browse to VMware View installation media, and click VMware-viewconnectionserver-x86_64-6.0.1.
Click Run.

At the Welcome screen, click Next.

2

3

4

5. Agree to the End User License Agreement, and click Next.

6. Keep the default installation directory, and click Next.

7. Select View Standard Server, and click Next.

8. At the Data Recovery screen, enter a backup password, and click Next.
9

Allow View Server to configure the Windows firewall automatically, and click Next.
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10. Authorize the local administrator to administer View, and click Next.

11. Choose whether to participate in the customer experience improvement program, and click Next.
12. To finish installing View Connection Server, complete the installation wizard.

13. Click Finish.

14. Reboot server.

Configuring the VMware Horizon View Connection Server
1. Opena Web browserto <view connection server FQDN>/admin

Loginasadministrator

Under Licensing, click Edit License...

Enter a valid license serial number, and click OK.

Open View Configuration—>Servers.

In the vCenter Servers tab, click Add.

Enter vCenter Server credentials, and click Next.

At the View composer screen, select View Composer co-installed with vCenter Server, and click Next.
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At the View composer domains screen, click Add.
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. Enter full domain name and user credentials.
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=

. At the storage screen, select Reclaim VM disk space, and select Enable View Storage Accelerator.
. Change the Default host cache size to 1.5GB, and click Next.
13. At the ready to complete screen, click Finish.

=
N

Setting up a Windows 7 Enterprise (x86) ESXi base image VM
1. Loginto vCenter via the VMware Web client.

2. Click the Virtual Machines tab.

3. Right-click, and choose New Virtual Machine.

4. Select Create a new virtual machine.

5. Choose Custom, and click Next.

6. Assign the name View—-gold, and click Next.

7. Select the appropriate host, and click Next.

8. Select the appropriate storage.

9. Choose Virtual Machine Version 11, and click Next.

10. Choose Windows, choose Microsoft Windows 7 (32-bit), and click Next.

11. For CPUs, select one virtual processor socket, select two cores per virtual socket, and click Next.
12. Choose 1.5 GB RAM, and click Next.

13. For the number of NICs, click 1; select VMXNET 3; and click Next.

14. Leave the default virtual storage controller, and click Next.

15. Choose to create a new virtual disk, and click Next.

16. Make the OS virtual disk size 24 GB, choose Thin Provision, specify the OS datastore on the external storage, and

click Next.
17. Keep the default virtual device node (0:0), and click Next.
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18. Click Finish.

19. Click the Hardware tab, CD/DVD Drive, and connect the VM virtual CD-ROM to the Microsoft Windows 7 x86
installation disk.

20. Click OK.

Installing Windows 7 Enterprise (x86) on ESXi base image VM
1. When the installation prompts you, press any key to begin setup.

2. Enter your language preferences, and click Next.

3. Click Install.

4. Accept the license terms, and click Next.

5. Select Custom, and select the drive that will contain the OS.

6. Click Install.

7. Type user for the username, and click Next.

8. Enter no password, and click Next.

9. Atthe system protection screen, select Use recommended settings, and click Next.

10. Enter your time zone, and click Next.

11. Select the Work Network setting, and click Next.

12. Install VMware Tools, and select Complete Installation. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

13. Reboot.

14. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

15. Join the domain and restart the VM.

16. Install Microsoft Office Professional Plus 2010.

Installing the VMware Horizon View 6 agent
1. Browse to the VMware Horizon View 6 media, and run the VMware-viewagent file.

Click Run.
At the Welcome screen, click Next.
Accept the VMware end user license agreement, and click Next.
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Select defaults, and click Next.
6. Click Install.

Configuring Regedit for QuickPrep
1. Click Start>Run, and type regedit

2. Browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\vmware-viewcomposer-ga.
3. Right-click SkipLicenseActivation, and click Modify.

4. Change the value from 0 to 1.

5. Shut down the machine, and take a snapshot of the final disk image.

Deploying Virtual Desktops using VMware Horizon View
1. Open the View Administrator.

2. loginasadministrator

3. Under Inventory, click Pools, and click Add.
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4, Select Automatic Pool, and click Next.
5. Select Dedicated, and click Next.
6. Select View Composer linked clones, and click Next.
7. Forthe pool ID and display name, type pool, and click Next.
8. Leave the pool settings as defaults, and click Next.
9. Under Naming Pattern, enter an appropriate name pattern for the pool.
10. Under Pool Sizing, type 150 for Max number of desktops and the number of spare (power on) desktops.
11. Select Provision all desktops up-front, and click Next.
12. Select the defaults under View Composer Disks, and click Next.
13. Under Storage Optimization, select Do not use VMware Virtual SAN.
14. Under vCenter Settings, select one of the following, depending on where you are deploying virtual machines:
e Parent VM
e Snapshot
¢ VM folder location
e Host or cluster
e Resource pool
e Datastores
15. Under Advanced Storage Options, select Use View Storage Accelerator (OS disk, 7 days).
16. Under Guest customization, select the following:
e Domain: domain.local
e AD container: OU=Computers, OU=LoginVSIT
17. Select Use Quick Prep, and click Next.
18. Click Finish.
19. After this wizard finishes, select Entitle users.
20. Select the LoginVSI group and click OK.
Installing the Login VSI 4 benchmark

Setting up a VM to host the Login VSI share
1. Connect to an infrastructure server via the VMware web client.

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

Choose Custom, and click Next.

Assign the name VSI share to the virtual machine, and click Next.

Select infral as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 11, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

For CPUs, select one virtual processor socket, select two cores per virtual socket, and click Next.
10. Choose 4 GB RAM, and click Next.

11. For the number of NICs, click 1; select VMXNET3; connect to the PRIV-NET network; and click Next.
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12. Leave the default virtual storage controller, and click Next.
13. Choose to create a new virtual disk, and click Next.
14. Make the OS virtual disk size 100 GB, choose thin-provisioned lazy zeroed, specify external storage, and click
Next.
15. Keep the default virtual device node (0:0), and click Next.
16. Click Finish.
17. Right-click the VM, and choose Edit Settings.
18. Click the Resources tab, and click Memory.
19. Select Reserve all guest memory, and click OK.
20. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
21. Start the VM.
Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open avirtual machine console on VSlishare.
Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.
Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.
Click Custom.
Click the Disk, and click Drive options (advanced).
Click New=>Apply=>Format, and click Next.
After the installation completes, click OK to set the Administrator password.
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. Enter the administrator password twice, and click OK.

[y
[any

. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to VSIShare, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start->Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
Uncheck the TCP/IP (v6) checkbox.
d. Select TCP/IP (v4), and choose Properties.
e. Setthe IP address, subnet, gateway, and DNS server.
Installing the Login VSI benchmark on VSI_share
1. Loginto VSI_Share.
2. Create afolder named c:\share

3. Right-click the c:\share folder, and click Properties.
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Click the Sharing tab, and click Share.

Add everyone, system, and administrators to the Read/Write group, and click Share.
Unpack the Login VSI install media.

Open Datacenter setup\setup.exe.

At the welcome screen, click Next.
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Select the share named \\vsishare\share, and click Next.
10. To start the Management Console when the setup is completed, check the Start Login VSI Management Console
checkbox, and click Finish.
11. At the management console, enter the path to your login VSI license file, and click save.
Configuring Login VSI: AD setup
1. Open the VSI management console and click 1. AD setup.

2. Enter the following:

Base OU DC=domain, DC=local
Username LoginVsSI

Password (enter password here)
Domain (auto detect checked)
Number of users 150

Formatting length 1

Launcher user Launcher-v4

Launcher password (enter password here)

Click save to .psl
3. Copy the VSIADSetup.ps1 file to \\DC1\cS
4. Loginto DC1, and execute the VSIADSetup.psl in Windows PowerShell™.
Creating Windows 7 Enterprise x64 image VSI Launchers
Using the vSphere client, we created a Windows 7 Enterprise x64 VM with 2 vCPUs and 8 GB of memory.

Installing VMware View Client on the launcher
1. Accept the VMware license terms.

2. Select default options.
3. Accept or change the destination folder.
4. Click Install.

Installing Virtual Audio Cable
By default, the virtual launchers cannot render audio, so we installed Virtual Audio Cable version 4.10 from

software.muzychenko.net/eng/vac.htm.

1. Download and extract the media.

Click Setup.

To begin the install, click Yes.

To accept the software license agreement, click | accept.
Click Install.
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Converting the launcher VM to a template
1. InvSphere Client, right-click the launcher VM, and select Template=>Convert to Template.

Deploying the launchers VM from the launcher template
1. InvSphere Client, browse to Home—>VMs and Templates.

To deploy a virtual machine from the template, right-click the launcher template.
As the new VM name, type launcher_1, and click Next.

Click Datacenter, and click Next.

Click the launcher server, and click Next.

Select the appropriate storage, and click Next.

Select customization using existing customization specifications, select the appropriate file, and click Next.
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To deploy the new VM, click Finish.

9. Repeat steps 1 through 8 to deploy more launchers.
Configuring VSI Launchers for testing

After all 6 launchers are configured and in an idle state, configure the Login VSI test harness to add them to

available launcher capacity.

1. Logon to VSI_Share as DOMAIN\administrator.
Open the Login VSI management console.
Click 2. Add Launchers.
At the Add launchers wizard, click Next.
Click batch entry and enter the following:
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Name=launcher
Start number=1
Increment=1
Count=6
Maximum capacity=30
Formatting length=2
6. Click Next.
7. Click Finish.
Running the Login VSI benchmark
Before we ran our test, we executed assign_user.ps1 on the VMware View server and statically assigned
login_VSI users to virtual desktops, so persona data would not be created randomly in testing. Next, we ran a profile
create job in Login VSI to fully initialize each user’s profile. Finally, we used six launchers to run a Knowledge Worker
workload. For more information on how to run a Login VSI test, see

www.loginvsi.com/documentation/index.php?title=Main Page.
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